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ªÃcov	euq	o	,oviuqra	mu	me	)sale	sadot(	4H	sgat	sa	arap	3H	sgat	sa	raretla	rasicerp	ªÃcov	odnauq	:olpmexe	mu	moc	ossi	rednetne	somaV	D	+	dmc	:caM	D	+	lrtC	:swodniW	rosruC	tceleS-itluM	.alusu¡Ãlc	ed	sotxetnoc	ed	aicnªÃrefer	an	lanoicidnoc	arodarepo	alusu¡Ãlc	a	odnauq	ed	atelpmoc	atsil	a	rartnocne	edop	ªÃcoV	"/	$	oviuqrA	^	|	$	deltitnU	^	/	~
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serodarepo	,}"	edoMgubednI	!&&	elbaliavasreggubeD	":"	","	,"trats.gubed.noitca.hcnebkrow"	:"odnamoc"	,"5f"	:"alcet"{	:))NOSJ(	o£Ãrdap	odalcet	ed	sohlata	rirba	:saicnªÃreferp(	NOSJ	o£Ãrdap	odalcet	on	etnematerid	gnidnibyek	ed	alusu¡Ãlc	amu	razilausiv	edop	m©ÃbmaT	:)oslaf	©Ã	edoMgubednI	otxetnoC(	o£Ã§Ãaruped	ed	odom	on	¡Ãtse	o£Ãn
rotide	o	e	)oriedadrev	©Ã	elbaliavasreggubeD	txetnoC(	lev​Ãnopsid	odairporpa	rodaruped	mu	¡Ãh	odnauq	odavita	©Ã	³Ãs	euq	,5F	odalcet	ed	ohlata	o	iussop	odargetni	aditrap	ed	o£Ã§Ãaruped	ed	odnamoc	o	,olpmexe	roP	.lauta	otxetnoc	ues	o	moc	odroca	ed	sodnamoc	sues	rasseca	edop	ªÃcov	,odnamoc	ed	atelap	amu	ed	aduja	a	moc	P	+	TFIHS	+	DMC
:caM	P	+	tfihS	+	lrtC	:swodniW	odnamoC	ed	atelaP	...	o£Ãrdap	odalcet	ed	sohlata	me	//	:olpmexe	mu	¡Ãtse	iuqA	.sonretni	sodnamoc	etlusnoc	,sotnemugra	merit	euq	sodnamoc	erbos	seµÃ§Ãamrofni	siam	retbo	araP	.)NOSJ(	odalcet	od	sohlata	ed	odnamoc	o	rirbA	:saicnªÃreferp	sa	moc	)P	+	tfihS	+	lrtC	xuniL	,swodniW(	p--	§Â	¡​â	¡​â	¡​â	¡​â(	odnamoc	ed
atelap	ad	nosj.sgnidnibyek	oviuqra	o	rirba	edop	m©Ãbmat	ªÃcoV	.odnauq	lanoicpo	alusu¡Ãlc	ad	s©Ãvarta	sadavita	o£Ãs	evahc	ed	seµÃ§Ãagil	saus	odnauq	erbos	onif	elortnoc	mu	ecenrof	SV	ogid³ÃC	O	â	​	â	​	â	​	â	​	â	​	â
​.action.inplaceplaceplaceplaceplaceplaceplaceplaceplaceplaceplaceplaceplaceplaceplaceplaceplaceplaceplaceplaceplaceplaceplaceplaceplaceplaceplaceplaceplace.	â	​	â	​	â§	-	~	(Windows,	linux	shift	+	alt	+	direct)	Reduce	selection	ast	Ã	¢	.action.showallsymbols	Go	to	Line	...	2/3/2022	How	to	add	a	key	combination	to	an	action,	for	example,	add	CTRL
+	D	to	delete	rows	Locate	a	rule	that	shoots	AÃ	In	the	standard	keyboard	shortcuts	and	write	a	modified	version	of	it	in	your	keybindings.json	file:	//	original,	in	standard	keyboard	shortcuts	{"key":	"Ctrl	+	Shift	+	K",	"	":"	Editor.Action.Deletelines	","	When	":"	editorTextFocus	"},	//	modified,	user	/	keybindings.json,	ctrl	+	d	now	also	will	shoot	this
action	{"	key	":"	Ctrl	+	D	","	Command	":"	Editor.Action.deletelines	","	When	":"	EditorTextFocus	"},	how	can	I	add	a	key	link	to	certain	file	types	only?	3.	Note:	On	Linux,	Visual	Studio	Code	detects	the	current	keyboard	layout	at	startup	and	caching	these	information.	Troubleshooting	shortcuts	to	troubleshoot	shortcuts,	you	can	run	the	developer
command:	Switch	solutions	of	keyboard	shortcut	problems.	This	is	useful	if	you	usually	run	the	same	operation	in	a	specific	file	or	folder.	[ServiceSociation	Odechavaves]:	/	Event	Keydown	Received	-	Modifiers:	[Meta],	Capigo:	Bar,	Keycode:	191,	Key:	/	[ServiceDeconoming	Odechavaves]:	|	Event	Keydown	Converted	-	Modifiers:	[Meta],	Capigo:	Bar,
Keycode:	85	('/')	[KeybindingService]:	|	Solving	Meta	+	[bar]	[keybindingservice]:	\	of	2	keyboard	shortcut	entries,	corresponding	to	editor.action.COMMENTLINE,	when:	EditorTextFocus	&&!	Editor	Reading,	Source:	Embedded.	You	can	view	the	default	keyboard	shortcuts	as	a	JSON	file	using	the	Preferences	command:	Open	the	default	keyboard
shortcuts	(JSON).	You	can	then	press	the	desired	keyboard	shortcut	and	check	which	keyboard	VS	³	detects	which	command	you	are	calling.	We	also	have	a	printable	version	of	these	keyboard	shortcuts.	Below	you	can't	see	that	Ctrl+Shift+P	is	linked	to	Show	all	commands	to	enable	the	Command	Palette.	Unfortunately,	at	the	moment,	there	is	a
process	of	trial	and	error.	For	example,	the	key	binding	below	triggers	the	Extract	Refactoring	Action	µi³say:	{	"key":	"ctrl+shift+r	ctrl+e",	"command":	"editor.action.codeAction",	"args":	{	"kind":	refactor.extract.function	}	}	This	is	covered	in	detail	in	the	Refactoring	³,	where	you	cannot	learn	about	different	types	of	³	µI	mean	Action	and	how	to
prioritize	them	in	the	case	of	multiple	refactoringµ	But	can	you	maximize	your	efficiency	with	the	help	of	this	editor?	More	precisely:	Reference:	Virtual	Key	³	(Windows)	tab	for	VK_TAB	(0x09)	;	for	VK_OEM_1	(0xBA)	=	for	VK_OEM_PLUS	(0xBB)	,	for	VK_OEM_COMMA	(0xBC)	-	for	VK_OEM_MINUS	(0xBD)	.	Customize	advanced	All	keyboard	shortcuts
in	VS³Isay	can	be	customized	via	keybindings.json	file.	After	that,	you	need	to	use	the	up	and	down	arrows	on	your	keyboard	to	find	the	file	you	do	not	need	to	open.	If	the	key	binding	does	not	have	a	when	clause,	it	will	be	available	globally	all	the	time.	You	need	to	type	a	keyword	related	to	the	command	and	find	it,	instead	of	navigating	menus	³
menus.	Help	>	Keyboard	shortcut	reference	displays	a	PDF	condensed	version	suitable	for	printing	as	an	easy	reference.	Here	is	an	example	of	replacing	the	Enter	key	to	print	some	text:	{	"key":	"enter",	"command":	"type",	"args":	{	"text":	"Hello,	World"	},	"when":	"editorTextFocus"	}	The	receive	{"text"	type	command:	"Hello	World"}	as	your	first
argument	and	add	"Hello	World"	to	the	file	instead	of	producing	the	default	command.	This	uncrashed	software	is	designed	by	Microsoft	as	the	Cross-platform	IDE	that	can	be	used	on	Linux,	Mac,	and	Windows.	If	you	don't	visit	using	Windows	or	Linux,	Linux,	arap	SV	ogid³Ãc	od	sohlata	so	macifidom	seµÃsnetxe	satsE	.saroh	sair¡Ãv	me	otejorp	mu	me
otsag	opmet	o	azuder	e	odalcet	ues	o	siam	rasu	a	ecemoC	.]hsalS[+atem	omoc	odahcapsed	©Ã	e	)/(	hsalS	alcet	a	arap	©Ã	oxiab	arap	alcet	ed	otneve	odnuges	O	.edoC	SV	od	ecafretni	an	sovita	e	siev​Ãsiv	sotnemele	sod	odnedneped	,socif​Ãcepse	serolav	e	otxetnoc	ed	sevahc	sair¡Ãv	enifed	edoC	SV	O	.salcet	ed	seµÃ§Ãagil	uo	sodnamoc	rartnocne	a	aduja
o	euq	opot	on	asiuqsep	ed	axiac	amu	met	m©ÃbmaT	...	,}	.atierid	a	arap	ates	ed	alcet	an	eugerrac	,rartnocne	o	odnauQ	.oxiaba	aiel	rovaf	rop	,etnerefid	odalcet	ed	tuoyal	mu	rasu	ªÃcov	eS	.nosj.sgnidnibyek	matide	es	odnauq	salcet	ed	o£Ã§Ãagil	ed	arger	a	rizudortni	a	aduja	euq	tegdiw	mu	m©Ãbmat	¡ÃH	:)a§ÃnarF(	sªÃcnarf	odalcet	ed	tuoyal	mu	asu
es	odnauq	o£Ãrdap	odalcet	ed	sohlata	ed	sarger	sa	macif	omoc	¡Ãtse	iuqa	,olpmexe	roP	.o£Ãrdap	sarger	sa	mevargerbos	sale	euq	missa	odnitimrep	,o£Ãrdap	sarger	sad	lanif	oa	o£Ã§Ãucexe	ed	opmet	me	sadaxena	o£Ãs	nosj.sgnidnibyek	sianoicida	sarger	sA	.sol-¡Ãzilauta	edop	ªÃcov	omoc	evercsed	e	)odalcet	ed	sohlata(	o£Ãrdap	sohlata	so	atsil	anig¡Ãp
atsE	.odalcet	ues	od	tuoyal	o	moc	odroca	ed	odalcet	ed	sohlata	rev	edop	ªÃcov	,adnia	etnatropmi	siaM	)SOcam	me	odalcet	ed	sohlatA	>	saicnªÃreferP	>	ogid³ÃC(	.sadimerp	salcet	sa	evercsed	euq	alcet	amu	:rop	atsopmoc	©Ã	arger	adaC	odalcet	od	sargeR	.siev​Ãnopsid	seµÃ§Ãa	sa	odnasu	salcet	saus	raicinier	/	revomer	/	raretla	etnemlicaf	edop	ªÃcov	e
salcet	mes	e	moc	siev​Ãnopsid	sodnamoc	so	sodot	atsil	elE	.cte	)EDx0(	7_MEO_KV	arap	'	)DDx0(	6_MEO_KV	arap	]	)CDx0(	5_MEO_KV	arap	\	)BDx0(	4_MEO_KV	arap	[	)0Cx0(	3_MEO_KV	arap	`	)FBx0(	2_MEO_KV	arap	/	)EBx0(	DOIREP_MEO_KV	arap	.edadivitudorp	aus	a	rarohlem	a	ol-¡Ãduja	edop	euq	atsil	asson	ad	setneicife	siam	sohlata	sod	mu	©Ã
etsE	.sadanoisserp	o£Ãs	odnauq	odizudorp	retcarac	o	moc	etnemairassecen	manoicaler	es	o£Ãn	e	siautriv	salcet	arap	gnirts	ed	seµÃ§Ãatneserper	o£Ãs	amica	salcet	sA	.amrofatalp	aleuqa	arap	sevahc	sa	ajev	other	editors,	so	you	don't	need	to	learn	new	keyboard	shortcuts.	There	is	also	a	category	of	µ	extensions	Keymaps	in	the	Market.	A	Linux	ctrl	+
g)	workbench.	action.	gotoline	VÃ¡	para	Arquivo	...,	Quick	Open	'~	~p	(Windows,	Linux	Ctrl	+	P)	Workbench.	action.	quickopen	VÃ¡	to	Symbol	...	Note:	If	you	visit	this	page	on	A	Mac,	you	see	the	key	links	for	the	Mac.	},	{"Key":	"Tab",	"Command":	"AcceptedSugnestion",	"When":	"Language	support	-	Our	good,	best,	best	language	grid	to	see	what	you
can	expect	from	debugging	-	is	©	where	the	code	vs	Really	shines	node.	js	-	end	to	end	node.	js	Scenario	with	a	Sample	App	Common	Questions	How	can	I	find	out	which	command	is	©	thanks	to	a	specific	key?	After	typing	the	desired	key	combination,	you	can	press	ENTER	and	a	rule	snippet	will	be	inserted.	For	a	good	experience,	we	recommend
restarting	the	VS	code	if	you	change	the	keyboard	layout.	Toggle	sidebar	windows:	Ctrl	+	B	Mac:	CMD	+	B	is	times	when	writing	the	code,	you	want	to	use	the	full	width	of	the	editor.	This	will	open	your	KeyBindings	file.	json,	where	you	can	overwrite	the	default	tables.	To	remove	a	specific	key	link,	add	a	-	to	the	command	and	the	rule	will	be	a
removal	rule.	This	action	will	help	you	open	the	selected	file,	which	will	go	in	the	background	while	you	can	continue	to	open	new	files.	This	will	find	each	H3	tag	and	give	you	an	active	cursor	for	additional	action.	To	help	with	this,	files	>	Preferences	>	Keymaps	shows	a	list	of	popular	keymap	extensions.	Considering	the	emergence	of	cross-platform
applications,	many	programmers	use	the	Visual	Studio	code	for	personal	or	commercial	applications.	The	list	does	not	exist	exhaustive	and	you	can	find	others	when	the	clause	searching	and	filtering	in	the	Keyboard	Shortcut	Editor	(Preferences:	Open	keyboard	shortcuts)	or	reviewing	the	default	keyboard	JSON	file	(Preferences:	Open	default
keyboard	shortcuts	(JSON).	O	cÃ³digo	do	Visual	Studio	permite	odnauq	odnauq	:*	+	lrtC	omoc	odaziredner	aroga	©Ã	)a§ÃnarF(	sªÃcnarf	odalcet	ed	tuoyal	mu	rasu	oa	odidivid	rotide	o	,olpmexe	roP	.odalcet	od	etnematerid	saferat	sad	airoiam	a	keybindings.json,	keybindings.json,	VS	Code	highlights	misleading	key	bindings,	those	that	are	represented
in	the	file	with	the	character	produced	under	the	standard	US	keyboard	layout,	but	that	need	pressing	keys	with	different	labels	under	the	current	system's	keyboard	layout.	no	more	rules	are	processed.	a	command	containing	the	identifier	of	the	command	to	execute.	Keyboard	layout-independent	bindings	Using	scan	codes,	it	is	possible	to	define
keybindings	which	do	not	change	with	the	change	of	the	keyboard	layout.	Custom	keybindings	for	refactorings	The	editor.action.codeAction	command	lets	you	configure	keybindings	for	specific	Refactorings	(Code	Actions).	The	most	common	problem	is	a	syntax	error	in	the	file.	We	can	help	you!	We	have	found	the	best	11	tricks	for	Visual	Studio
Code.	Chords	(two	separate	keypress	actions)	are	described	by	separating	the	two	keypresses	with	a	space.	¢Ã​Â§Â¢Ã​Â​ÂS	(Windows,	Linux	Ctrl+Shift+S)	workbench.action.files.saveAs	Close	¢Ã​Â​ÂW	(Windows,	Linux	Ctrl+W)	workbench.action.closeActiveEditor	Close	Others	¢Ã​Â¥Â¢Ã​Â​ÂT	(Windows,	Linux	)	workbench.action.closeOtherEditors	Close
Group	¢Ã​Â​ÂK	W	(Windows,	Linux	Ctrl+K	W)	workbench.action.closeEditorsInGroup	Close	Other	Groups	workbench.action.closeEditorsInOtherGroups	Close	Group	to	Left	workbench.action.closeEditorsToTheLeft	Close	Group	to	Right	workbench.action.closeEditorsToTheRight	Close	All	¢Ã​Â​ÂK	¢Ã​Â​ÂW	(Windows,	Linux	Ctrl+K	Ctrl+W)
workbench.action.closeAllEditors	Reopen	Closed	Editor	¢Ã​Â§Â¢Ã​Â​ÂT	(Windows,	Linux	Ctrl+Shift+T)	workbench.action.reopenClosedEditor	Keep	Open	¢Ã​Â​ÂK	Enter	(Windows,	Linux	Ctrl+K	Enter)	workbench.action.keepEditor	Copy	Path	of	Active	File	¢Ã​Â​ÂK	P	(Windows,	Linux	Ctrl+K	P)	workbench.action.files.copyPathOfActiveFile	Reveal	Active
File	in	Windows	¢Ã​Â​ÂK	R	(Windows,	Linux	Ctrl+K	R)	workbench.action.files.revealActiveFileInWindows	Show	Opened	File	in	New	Window	¢Ã​Â​ÂK	O	(Windows,	Linux	Ctrl+K	O)	workbench.action.files.showOpenedFileInNewWindow	Compare	)	R	+	floor	xunil,	swodniw	(râ	€	¢	Noisserpxe	Raluger	ESU	elggot	drowerelohwhcraeselfelgog	)	C	+	soil	xunil,
swodniw	(c	SELIF	is	not	ECALPER	HCRAES.WEIV.HCNEBKROW)	F	+	TFIHS	+	LRTC	XUNIL,	SWODIW	(F)	ã	¢	HCRAES	WOHS	DI	DNAMMOC	YEK	DNAMMOC	HCRAES	LAKRETELGGOPT.LANDOMRET.NOITCA.HCNEBKROW)	`+	LRTC	Xunil,	Swodniw	(`ÂƒÂœÃ	¢	LAKERET	DETARGET	ELGGOT	EDISOTWEIVERPWOHS.NWODKRAM)	V	K	+	LRTC
XUNIL,	SWODIW	(in	Kâ~ÂœÃ	¢	Edis	EHT	WeIverp	Ne	Weiverpwohs.nwodram)	V	+	TFIHS	+	LRTC	XUNIL,	SWODIW	(VÂ	~	¢	¢	Â	‡	‡	Ã	¢	weiverp	nwodram	elggot	elongocevitnepo.lanikret.noitca.hcnebkrow)	C	+	TFIHS	+	LRTC	XUNIL,	SWODIW	(CÂ~ÂœÃ	¢	Â§Â	‡	Ã	¢	tpmorp	Dnammoc	wen	virtue	...	Â	‡	Ã	¢	TUPT	uo	wohs	snoisnetxe.weiv.hcnebkrow)
x	+	tfihs	+	lrtc	xunil,	swodniw	(xâ	€	¢	snoisnetxe	wohs	wrest.weiv.hcnebkrow)	D	+	TFIHS	+	LRTC	XUNIL,	SWODIW	(DÂ~	Ã	¢	Â	‡	‡	Ã	¢	nur	wohs	mcs.weiv.hcnebkrow)	G	+	TFIHS	+	LRTC	XUNIL,	SWODIW	(GÂ§Â	‡	Ã	¢	ÂƒÂ	¢	Lortnoc	ecruos	wohs	hcres.weiv.hcnebkrow)	F	+	TFIHS	+	LRTC	XUNIL,	SWODIW	(F)	Ã	¢	hcres	wohs
rerolpxe.weiv.hcnebkrow)	E	+	TFIHS	+	LRTC	XUNIL	XUNIL,	SWODIW	(Eã~ÂœÃ	¢	Â§Â	‡	Ã	¢	Sucof	Elggot	/	REROLPXE	Wohs	ytilibisvabedielggot.noitca.hcnebkrow)	B	+	lrtc	xunil,	swodniw	(bâ	€	™	-	+	lrtc	noitca.hcnebkrow)	with	k	+	lrtc	YEK	DNAMMOC	YALPSID	HTI	WELIFERAPMOC.NOITCA.SELIF.HCNEBKROW	HTIW	ELIF	Switch	details	of	the
search	details	‡	Â	Â	Â	Â	Â	Â	Â	œ	ÂŒ	ÂŒ	ÂŒ	ÂŒ	ÂŒ	ÂŒ	ÂŒ	ÂŒ	ÂŒ	Â	‡	Â	®	Â	Â	Â	Â	Â	Â	Â	Â	®	)	Workbench.Action.OpenGlobalkeyBindings	Open	User	Exples	Workbench.Action.OpentRephos	Select	Color	Theme	Ã	¢	k	(Windows,	Linux	Ctrl	+	K	Ctrl	+	T)	Workbench.Action.SelectTheme	Language	Workbench.Action.configurelocale	Debug	command
key	command	ID	switch	switch	point	f	editor.debug.action.togglebreakpoint	Start	f5	workbench.action.debug.start	Continue	F5	Workbench.Action.debug.Continue	Start	(no	debugging)	F5	(Windows,	Linux	Ctrl	+	F5)	Workbench.Action.debu	g.run	pause	f6	workbench.action.debug.pause	pass	to	f11	workbench.action.debug.Stepinto	Tasks	Command
Key	Command	ID	Running	Task	Task	™	B	(Windows,	Linux	Ctrl	+	Shift	+	B)	Task.	Bench.Action.Action	.bubild	perform	workbench.Action.Tasks.Test	Extensions	Command	ID	Key	Installing	extension	Workbench.Extensions.Action.InstallExtension	Show	Extensions	Installed	Workbench.Extensions.Action.ShowInstallDExtensions	Display	Outdated
workbench.extensions.action.listOutdatedExtensions	Show	extensionsµrecommended	workbench.extensions.action.showRecommendedExtensions	Show	extensionsµpopular	workbench.extensions.action.showPopularExtensions	Update	all	extensions	workbench.extensions.action.updateAllExtensions	PrÃãµ	³...	See	more	at	the	Marketplace.	Some	of	the
commands	included	below	do	not	have	standard	keyboard	shortcuts	and	are	therefore	displayed	as	not	assigned,	but	you	cannot	assign	³	keyboard	shortcuts.	Tip:	Click	on	an	extension	block	above	to	read	the	description	and	revisions	µ	decide	which	extension	is	best	for	you.	4.	Here,	you	can	also	find	µ	key	combinations	relevant	to	each	command.
You	cannot	open	this	editor	by	going	to	the	menu	under	File	>	Preferences	>	Keyboard	Shortcuts.	In	the	Keyboard	Shortcut	Editor,	you	cannot	filter	specific	keys	to	see	which	commands	are	linked	to	which	keys.	Keyboard	Shortcuts	Editor	Visual	Studio	Code	provides	an	advanced	and	easy	experience	of	editing	keyboard	shortcuts	using	the	Keyboard
Shortcuts	editor.	if	a	rule	is	found	and	has	a	set	of	commands,	the	command	is	executed.	Visual	Studio	Code	A	popular	editor	used	by	developers	worldwide.	Â​ÂÂ​O	(Windows,	Linux	Ctrl+Shift+O)	workbench.action.gotoSymbol	Show	Issues	Â​	​	​	​	​	​	​	​	​	​	​	​	​	​	​	​	​	³	InGroup	Back	To¢-	(Windows	Alt+Left,	Linux	Ctrl+Alt+-)	workbench.action.navigationBack	Back
Back	Back	Back	Back	Back	Back	Back	Back	Back	to	Quick	Input	-	(Windows	Alt+Left,	Linux	Ctrl+Alt+-)	workbench.action.InputInputBack	Go	Forward	siaM	on	oir¡ÃusU	od	sodalceT	rartsoM	odnamoc	o	moc	odalceT	ed	sohlatA	ed	rotide	on	edoC	SV	on	oir¡Ãusu	olep	odacifidom	odalcet	ed	ohlata	reuqlauq	ribixe	edop	ªÃcoV	...eliF	nepO	eliFdeltitnUovon
.soriehcif	.o£Ã§Ãca	.hcnebkrow	)N+lrtC	xuniL	,swodniW(	N​Â​Â¢Ã	eliF	weN	di	dnammoC	yeK	dnammoC	tnemeganaM	eliF	puorGsuoiverPoTrotidEevoM	.o£Ã§Ãca	roiretnA	opurG	od	ohlabart	ed	adacnab	a	arap	rotidE	revoM	puorGtxeNoTrotidEevoM	.o£Ã§Ãca	.hcnebkrow	)thgiR+tlA+lrtC	xuniL	,swodniW(	puorG	txeN	arap	rotidE	revoM
thgiRpuorGrotidEevitcAevoM	.o£Ã§Ãca	.hcnebkrow	)atieriD	K+lrtC	xuniL	,swodniW(	atieriD	puorG	rotidE	evitcA	evoM	tfeLpuorGrotidEevitcAevoM	.o£Ã§Ãca	.hcnebkrow	)tfeL	K+lrtC	xuniL	,swodniW(	tfeL	puorG	rotidE	evitcA	revoM	puorGnIthgiRrotidEevoM	.o£Ã§Ãca	.hcnebkrow	)nwoDegaP+tfihS+lrtC	xuniL	,swodniW(	£Î	¢Ã​Â​Â¢Ã§Â​Â¢Ã	K​Â​Â¢Ã	thgiR
rotidE	evoM	puorGnItfeLrotidEevoM	.o£Ã§Ãca	.)pUegaP+tfihS+lrtC	xuniL	,swodniW(	hcnebkrow	​​â¢Ã​Â​Â¢Ã§Â​Â¢Ã	K​Â​Â¢Ã	tfeL	rotidE	evoM	puorGtxeNsucof	.o£Ã§Ãca	.atierid	adacnab	an	serotide	ed	opurg	me	ocoF	puorGsuoiverPsucof	.o£Ã§Ãca	.adreuqse	ohlabart	ed	adacnab	an	serotidE	ed	opurG	on	ocoF	serotidE	ed	opurGdrihTsucof	.o£Ã§Ãca
.hcnebkrow	)3+lrtC	xuniL	,swodniW(	3​Â​Â¢Ã	serotide	ed	opurg	oriecret	on	ocoF	puorGrotidEdnoceSsucoF	.o£Ã§Ãca	.hcnebkrow	)2+lrtC	xuniL	,swodniW(	2​Â​Â¢Ã	serotide	ed	opurg	odnuges	on	ocoF	puorGrotidEtsriFsucoF	.o£Ã§Ãca	.hcnebkrow	)1+lrtC	xuniL	,swodniW(	1​Â​Â¢Ã	serotide	ed	opurg	oriemirp	on	ocoF	rotidEtilps	.o£Ã§Ãca	.hcnebkrow	)\+lrtC
xuniL	,swodniW(	\​Â​Â¢Ã	rotidE	tilpS	spuorGrotidEetagivan	.o£Ã§Ãca	.hcnebkrow	spuorG	rotidE	neewteB	elcyC	redloFesolc	.o£Ã§Ãca	.hcnebkrow	)F	K+lrtC	xuniL	,swodniW(	F	K	raxiab	arap	iuqa	euqilC	.o£Ã§Ãca	.hcnebkrow	)W+lrtC	xuniL	,swodniW(	rotidE	esolC	wodniWesolC	.o£Ã§Ãca	.)4F+tlA	xuniL	,swodniW(	W	ohlabart	ed	adacnab	amu	©Ã
wodniW	esolC	wodniWwen	.o£Ã§Ãca	.hcnebkrow	)N+tfihS+lrtC	xuniL	,swodniW(	N​Â​Â¢Ã§Â​Â¢Ã	alenaj	avoN	di	dnammoC	yeK	dnammoC	tnemeganaM	wodniW/rotidE	drawroFetagivan	.o£Ã§Ãca	.hcnebkrow	)-+tfihS+lrtC	xuniL	(...).	Generally,	programmers	pass	through	each	H3	tag	instance	and	change	each	tag.	When	using	a	keyboard	layout	other
than	the	US	standard,	Visual	Studio	Code	does	the	following:	All	key	µ	are	rendered	in	the	user	interface	using	the	keyboard	layout	of	the	current	system.	The	keybindings.json	file	is	observed	by	³	VS,	so	edit	it	while	³	VS	is	running.	//	To	remove	the	second	rule,	for	example,	add	in	keybindings.json:	{	"key":	"tab",	"command":	"-
jumpToNextSnippetPlaceholder"	}	Keyboard	Layouts	Note:	This	condition	relates	only	to	keyboard	shortcuts,	not	to	keyboard	shortcuts.		type	in	the	editor.	Different	keyboard	layouts	usually	reposition	the	virtual	keys	above	or	change	the	characters	produced	when	pressed.	The	distribution	of	keyboard	shortcuts	is	done	by	analyzing	a	list	of	rules	that
are	expressed	in	JSON.	Removing	a	specified	key	binding	rule	You	cannot	write	a	key	binding	rule	that	targets	the	rowing	of	a	specific	key	binding.	the	first	rule	that	corresponds,	both	the	key	and	in	terms	of	when,	A©	accepts.	The	following	modifiers	are	supported:	Platform	Modifiers	macOS	Ctrl+,	Shift+,	Alt+,	Cmd+	Windows	Ctrl+,	Shift+,	Alt+,
Win+	Linux	Ctrl+,	Shift+,	Alt+,	Meta+	The	following	keys	are	supported:	f1-f19,	a-z,	0-9	`,	-,	=,	[,	],	\,	;,	',	,,	.,	/	left,	up,	right,	down,	pageup,	pagedown,	end,	home	tab,	enter,	escape,	space,	backspace,	delete	pausebreak,	capslock,	insert	numpad0-numpad9,	numpad_multiply,	numpad_add,	numpad_separator	numpad_subtract,	numpad_decimal,
numpad_divide	Command	arguments	You	cannot	call	a	command	with	arguments.	Â​Â​O	(Windows,	Linux	Ctrl+O)	workbench.action.files.openFile	Save​	​	​	​	​	ÂÂ	lev​Ãssop	lev​Ãssop	iof	erpmes	,nosj.sgnidnibyek	o	moC	.etnednopserroc	ortsiger	ed	oviuqra	o	moc	ad​Ãas	ed	all	key	bindings	of	the	VS	Code,	but	it	can	be	difficult	to	make	a	small	adjustment,
especially	around	overloaded	keys	such	as	Tab	or	Escape.	To	set	up	keyboard	shortcuts	via	the	JSON	file,	open	the	Keyboard	Shortcuts	editor	and	select	the	Open	Keyboard	Shortcuts	(JSON)	button	to	the	right	of	the	editor's	title	bar.	When	a	key	is	pressed:	the	rules	are	evaluated	from	the	bottom	up.	Dive	in	and	start	exploring	these	keyboard
shortcuts	for	Visual	Studio	Code.	Choose	a	command	with	the	key	binding	that	you	think	is	overloaded	and	you	can	see	if	several	commands	are	defined,	the	origin	of	the	key	bindings,	and	when	they	are	active.	The	when	clause	is	evaluated	as	true	boolean	or	false	to	enable	key	bindings.	If	not,	try	removing	the	when	clause	or	choose	a	different	key.
For	example,	when	pressing	cmd+/	in	a	code	editor	on	macOS,	the	log	output	would	be:	[KeybindingService]:	/	Received	keydown	event	-	modifiers:	[meta],	code:	MetaLeft,	keyCode:	91,	key:	Meta	[KeybindingService]:	|	Converted	keydown	event	-	modifiers:	[meta],	code:	MetaLeft,	keyCode:	57	('Meta')	[KeybindingService]	\	The	keyboard	event
cannot	be	dispatched.	You	can	add	a	custom	keyboard	shortcut	to	do	exactly	what	you	want.	2.	But,	no!	This	is	not	how	it	is	done.	Available	Contexts	You	can	find	some	of	the	when	clause	contexts	available	in	the	when	clause	context	reference.	},	{	"key":	"tab",	"command":	"jumpToNextSnippetPlaceholder",	"when"	:	...	You	can	select	several	H3	tags
and	change	them	to	H4	in	one	go.	For	example,	Ctrl+K	Ctrl+C.	The	widget	listens	for	keystrokes	and	renders	the	serialized	JSON	representation	in	the	text	box	and	below	that,	the	keys	that	VS	Code	has	detected	in	the	current	keyboard	layout.	For	example,	the	key	binding	Cmd+\	in	the	US	keyboard	layout	will	be	shown	as	when	the	layout	is
changed	to	German.	The	dialog	box	for	inserting	the	keybinder	will	assign	the	correct	and	desired	keybinder	according	to	the	keyboard	layout.	BÃ¡sico	BÃ¡sico	Key	Command	Id	Crop	Line	(empty	selection)	Ã​	~	~	~	~	x	(Windows,	Linux	Ctrl	+	X)	Editor.Action.Ction	Line	Copy	(​	​	​	​	​	​	​	​	​	​	​	​	​	​	​	​	​	​	​	​	​	​	​	​	​	​	​	​	​	​	​	​	​	​	​	​	​	​	​	​	​Empty	SeleAction)	~	C	(Windows,	Linux	Ctrl	+	C)
Editor.Ction.Cort.ClipboardCopyCopy	I	have	already	â	â	â	ï	â	â	ï	â	â	ï	â	â	ï	â	ï	â	ï	â	i	â	âΤi	â‡	i	âPlex	i	âPlex	âΤi	â‡	i	â‡	i	â‡	i	â‡	i	â‡	i	â‡	i	â‡	i	â‡	i	â‡	i	â‡	i	â‡	i	â‡	i	â‡	i	â‡	i	â‡	i	â‡	i	â‡	i	â‡	i	â‡	i	â‡	i	â‡	i	â‡	i	â‡	i	â‡	i	â‡	i	â‡	i	â‡	i	â‡	i	â‡	i	â‡	i	â‡	i	â‡	i	â‡	i	â‡	i	â‡	i	â‡	i	â‡	i	â‡	i	â‡	i	â‡	i	â‡	i	â‡	i	â‡	i	â‡	i	â‡	i	â‡	i	â‡	â	³	i	âPlex	ei	âPlex	ei	âΤλis	i	â‡	i	â‡	i	~enter
(Windows,	linux	ctrl	+	shift	+	enter)	editor.action.insertlinebefore	moving	line	down	-	Â¥	âΤΟ		"(Windows,	Linux	Alt	+	Down)	Editor.Action.MovelinesDownloadWeaponMove	the	line	"Â¥	Â¥	â​		'(Windows,	Linux	Alt	+	Up)	Editor.Action.MovelinesUpaction	Copy	line	down​​	i​	​	​	​	​	³	​	​	​	​	​		'(Windows	SHIFT	+	ALT	+	UP,	Linux	Ctrl	+	Shift	+	Alt	+	Up)
Editor.Action.Copilinescimento	Undo	~	~z	(Windows,	Linux	Ctrl	+	Z)	Undo	Redo	Redo	~z	(Windows​	​	​	​	​	³	​	​	​	​	​	​	​	​	​	​	​	​	​	​	​	​	​	​	​	​	Linux	Ctrl	+	Y)	Redo	Add	selection	to	n	EXT	FIND	Match	Å	~	~	~	~	~	Ã¢	~	Ã¢	~	Ã¢	~	Ã¢	~	Ã¢	~	~	~	~	~	~	~	~	~	~	~	~	~	Ã¢	Ã¢	~	~	~	~	~	~	~	~	~	~	~	~	~	~	~	~	~	~	~	~	~	~	~	~	~	~	~	~	~	~	~	~	~	~	~	~	~	~	~	~	~	~	~	~	~
~	~	~	~	~	~	~	~	~	~	~	~	~	~	~	~	~	~	~	~	~	~	~	~	~	~	~	~	~	~	~	~	~	~	~	~	~	~	~	~	~	~	~	~	~	~	~	~	~	~	~	~	~	~	~	~	~	~	~	~	~	~	~	~	~	~	~	~	~	~	~	~	~	~	~	~	~	~	~	~	~	~	~	~	~	~	~	~	~	~	~	~	~	~	~	~	~	~	~	~	~	~	~	~	~	~	~	~	~	~	~	~	~	~	~	~	~	~	~	~	~	~	~	~	~	~	~	~	~	~	~	~	~	~	~	~	~	~	~	~	~	~	~	~	~	~	~	~	~	~	~	~	~	~	~
~	~	teCoCinescentouLected	Select	All	Current	Selection	Occurrences	â‡	i	â	í	âΤηei	â→ì	âΤηí	âΤΤΟ	âΤηí	âΤΟ	âΤηí	âΤΟ	âΤηí	âΤΟ	âΤΟ	Editor	(Windows,	Linux	Ctrl	+	Shift	+	L)	Editor.Action.SelectHighlights	Select	all	the	occurrences	of	the	current	word	â‡	~	~F2	(Windows,	Linux	+	Ctrl	+	F2)	Editor.Action.Cort.ChangeAll	Select	Current	Line	-
(Windows,	Linux	Ctrl	+	L)	Transverter	Insert	or	abbreviated	cursor	"Â¥	Â¥	Â¢	~	~	(Windows	Ctrl	+	Alt	+	Down,	Linux	Shift	+	Alt	+	Down)	Editor.Action.InsertCursorBelow	Insert	top	cursor	Â¥	Â¢	~	~	~	~	~	~	~	(Windows	Ctrl	+	ALT	+	UP,	Linux	Shift	+	Alt	+	Up)	Editor.Action.IntCursorAbove	Skip	to	correspondÃ§Ã§Ã£o	â	​	â	​	â	​	â	​	â	​	â	​	â	​	â	â	â	â	​	â	â
â	â	â	â	â	â	â	â	â	â	â	â	â	â	â	â	â	â	â	â	â	â	â	â	â	â	â	â	â	â	â	â	â	â	â	â	â	â	â	â	â	â	â	â	â	â	â	â	â	â	â	â	â	â	â	â	â	â	â	â	â	â	â	â	â	â	â	â	â	â	â	â	â	â	â	â	â	â	â	â	â	â	â	â	â	â	â	â	â	â	â	â	â	â	â	â	â	â	â	â	â	â	â	â	â	â	â	â	â	â	â	â	â	â	â	â	â	â	â	â	â	â	â	â	â	â	â	â	â	â	â	â	â	â	â	â	â	â	â	â	â	â	â	â	â	â	â	â	â	â	â	â	â	â	â	â	â	â	â	â	â	â	â	â	â	â	â	â	â	â	â	â	â	â	â	â	â	â	â	â	â	â	â	â	â	â	â	â	â	â	â	â	â	â	â	â
â	â	â	â	â	â	â	â	â	â	â	â	â	â	â	â	â	â	â	â	â	â	â	â	â	â	â	â	â	â	â	â	â	â	â	â	â	â	â	â	â	â	â	â	â	â	__	~	~	editor.Action.JUMPTOBRacket	indent	line	Ã	ÂÅ​]	(Windows,	Linux	ctrl	+])	editor.action.Indentlines	outtida	line	Ã	ÂÅ	Å​	~	~	~	[(Windows,	linux	ctrl	+	[)	editor.action.Action.Outdentlines	vÃood	for	the	cursorhome	line	entry	goes	to	End	of	Line	End	Cursorend	VÃ	i
ei	for	the	end	of	the	file	-	~	~	~	~	~	â​		"(Windows,	Linux	Ctrl	+	End)	CursorButton	Skip	to	file	login	-	~	~	~	~	~	~	(Windows,	Linux	Ctrl	+	Home)	Cursortop	Scroll	Line	Down"	AE​PoDown	(Windows,	Linux	Ctrl	+	Down)	scroll	scroll	line	UP	Å​OpageUp	(Windows,	Linux	Ctrl	+	Up)	ScrollLineUp	ScrollLineUp	scroll	page	Down	~~pag	(Windows,	Linux
ALT	+	PAGEOWN)	ScrollagePoDown	Scroll	page	·	~pageup	(Windows,	Linux	Alt	+	Pageup)	Folding	(collapse)	rule	"Â¥	Â¥"	(Windows,	Linux	Ctrl	+	SHIFT	+	[)	Editor.folffold	Unfold	(unfold)	rule	"Â¥	Â¥]	(Windows,	Linux	Ctrl	+	SHIFT	+])	Editor.Unfold	Fold	(collapse)	All	subregiµ	µ	µ	µ	​	​	​	​	​	​	µ	³	"~	~	~"	(Windows,	Linux	+	K	Ctrl	+	[)
Editor.FolderRecursively	unfold	(incolosity)	All	subregiOs~"	~"	~	~	~	~	~	~	~	~	~	~	~	~	~	~	~	~	~	~	~	~	c	(Windows,	Linux	Ctrl	+	K	Ctrl	+	0)	Editor.UnfoldRecursively	fold	(APSE	coll)	entline	Remove	Line	Comment	"~	Ã¢	~	~	~	~	~	~	~	~~~	(Windows,	Linux	Ctrl	+	K	Ctrl	+	U)	editor.action.RemoveLine	linear	line	comment	find	Replace"	Â¥	Â	¥
Â¥	Â¥	Â¥	Â¥	Â	¥	editor.Action.Ction.startFindReplaceAction	Find	the	prΕximum	ENTER.	​	.NextMatchFIntaction	Find	Previous	​​	​	​	​	​	​	Select	all	occurrences	to	find	matches	"Â¥	Type	(Windows,	Linux	ALT	ENTER)	Editor.Action.SelectAllMatches	Toggle	to	find	the	case"	Â¥	Â	¥	~	C	(Windows,	Linux	Alt	+	C)	C)	.rotide	.rotide	olep	evom	es	ªÃcov	euq	adidem
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VSCode	is	trying	to	activate	a	conda	virtual	environment	and	failing	to	do	so	(because	it	can't	run	conda.exe).	Odds	are	the	directory	that	contains	conda.exe	is	not	in	your	system	path.	The	easiest	way	to	fix	this	is	to	reinstall	Anaconda	taking	care	that	any	options	regarding	adding	it	to	your	path	are	checked.	08/07/2010	·	Take	the	VSCode	window
and	snap	it	to	the	outside	side	of	one	monitor,	then	scale	the	window	horizontally	across	the	two	monitors.	It	isn't	perfect	and	it's	annoying	to	work	with,	and	the	VSCode	editor	panes	won't	line	up	neatly	with	the	monitors,	but	if	it's	necessary	to	look	at	a	shitton	of	files	at	once	as	I	sometimes	do	because	project	...	The	VSCode	comment	shortcut	Mac	is
very	similar	to	the	Windows	version.	Comment-out	code	in	VSCode.	This	is	the	other	main	usage	of	comments.	Commenting-out	code	while	debugging.	This	is	probably	the	most	useful	shortcut	in	here.	Here's	how	to	do	it:	Select	the	text	or	code	that	you	want	to	comment	out	19/04/2020	·	Keyboard	Shortcuts:	React	in	VS	Code	#	vscode	#	react	#
javascript	#	beginners.	Honestly,	much	of	what	I've	learned	about	programming	in	general	seems	like	magic.	I	mean,	how	many	times	have	you	watched	a	code	along	video	and	seen	the	speaker	make	something	happen	instantly	without	ever	explaining	how	they	did	it?	In	this	module,	you'll	master	Visual	Studio	Code	basics.	In	just	one	minute,	I'll
help	you	migrate	all	your	settings	and	keyboard	shortcuts	from	your	previous	editor	to	VSCode.	You	can	migrate	from	Vim,	Sublime,	Atom,	Eclipse,	IntelliJ/JetBrains	IDE,	Xcode,	and	about	20	other	editors.	I've	got	you	covered.	Jump	right	in.	The	documentation	has	sections	that	describe	the	features	of	this	extension	(including	e.g.	keyboard
shortcuts).	This	repo	also	has	legacy	docs	in	the	wiki.	Questions,	Feature	requests	and	contributions.	If	you	face	any	issues,	please	open	an	issue	here.	Learn	best	VSCode	hotkeys	(hot	keys)	or	keyboard	shortcuts	after	already	gaining	some	experience	with	basics	of	vs	code	(or	change	them	to	your	own	vsc	key	bindings)	from	this	article	to	advance
your	knowledge	of	vscode	keyboard	shortcuts	which	should	improve	efficiency	writing	code	and	increase	overall	productivity.	This	tutorial	lists	some	of	the	best	VSCode	…	09/06/2021	·	Keyboard	shortcuts	in	predefined	keymaps.	When	consulting	this	page	and	other	pages	in	JetBrains	Rider	documentation,	you	can	see	keyboard	shortcuts	for	the
keymap	that	you	use	in	the	IDE	—	choose	it	using	the	selector	at	the	top	of	a	page.	14/01/2022	·	Keyboard	shortcuts.	JetBrains	Rider	has	keyboard	shortcuts	for	most	of	its	commands	related	to	editing,	navigation,	refactoring,	debugging,	and	other	tasks.	Memorizing	these	hotkeys	can	help	you	stay	more	productive	by	keeping	your	hands	on	the
keyboard.	All	default	shortcuts	are	configurable	and	you	can	also	assign	shortcuts	to	any	action	that	does	…	27/09/2016	·	Search	Open	Keyboard	Shortcuts;	Then	search	for	collapse;	Finally	click	the	+	sign	near	the	Collapse	All	and	Collapse	Folders	in	Explorer	options	and	set	the	shortcuts	like	I	did;	Or	you	can	open	keybindings.json	file	and	add	this
to	the	main	array.	05/03/2020	·	7.	Update	shortcuts.	One	last	thing	to	consider	is	customising	the	shortcuts/hotkeys	to	make	the	use	of	VSCode	more	comfortable.	The	default	shortcut	for	switching	between	VSCode	tabs	on	Mac	is	...	Learn	shortcuts	using	spaced	repetition	to	help	you	memorize	shortcuts	more	efficiently.	We'll	show	you	the	shortcuts
you	need	to	focus	on,	and	tell	you	exactly	when	to	practice	to	maximize	memory	recall.	We	will	notify	you	via	email	when	it's	time	to	practice.	It's	that	easy!	19/04/2020	·	Keyboard	Shortcuts:	React	in	VS	Code	#	vscode	#	react	#	javascript	#	beginners.	Honestly,	much	of	what	I've	learned	about	programming	in	general	seems	like	magic.	I	mean,	how
many	times	have	you	watched	a	code	along	video	and	seen	the	speaker	make	something	happen	instantly	without	ever	explaining	how	they	did	it?	07/12/2020	·	I	organized	the	keyboard	shortcuts	that	we	can	use	in	VScode	when	using	Jupyter	Notebook..	“VSCode	Jupyter	Notebook	Keyboard	ShortCuts”	is	published	by	bbyond.	25/06/2019	·	VS	Code
Tips	and	Tricks	Table	of	Contents	Basics	Insider	Version	of	VS	Code	Getting	Started	Command	Palette	Reference	keybindings	Quick	open	Navigate	between	recently	opened	files	Open	multiple	files	from	Quick	Open	CLI	tool.vscode	folder	Status	Bar	decorations	Customization	Change	your	theme	Change	your	keyboard	shortcuts	Keyboard	Reference
...	31/05/2018	·	Keyboard	shortcuts.	I	showed	you	a	lot	of	keyboard	shortcuts	up	to	now.	It’s	starting	to	get	complicated	to	remember	them	all,	but	they	are	a	nice	productivity	aid.	I	suggest	to	print	the	official	shortcuts	cheat	sheet,	for	Mac,	Linux	and	Windows.	Keymaps	All	keyboard	shortcuts	in	vscode	can	be	customized	via	the	User/keybindings.json
file.	To	configure	keyboard	shortcuts	the	way	you	want,	go	to	the	menu	under	File	>	Preferences	>	Keyboard	Shortcuts.	This	will	open	the	Default	Keyboard	Shortcuts	on	the	left	and	your	User/keybindings.json	file	where	you	can	overwrite	the	default	bindings	on	the	...	A	list	of	keyboard	shortcuts	for	VSCode.	Search	and	filter	shortcuts	to	find	what
will	speed	up	your	workflow.	See	all	combinations	mapped	onto	a	virtual	keyboard.	Add	these	shortcuts	to	your	personal	collections	to	build	your	knowledge	base.	All	VSCode	Shortcuts	for	MacOS,	Linux	and	Windows	Here	is	a	listing	of	all	VS	Code	shortcuts	for	all	popular	operating	systems	(Mac,	Linux,	and	Windows)	organized	and	listed	in	one
place.	These	shortcuts	are	taken	from	the	official	documentation	on	Microsoft	Visual	Studio	Code.	23/05/2020	·	Visual	Studio	Code	Keyboard	Shortcuts.	Visual	Studio	Code	Keyboard	Shortcuts.	Visual	Studio	Code	is	the	go-to	code	editor	for	Salesforce	developers.	It’s	free,	open-source,	and	available	for	Windows,	Linux,	and	macOS.	This	editor	has
easy-to-install	extensions	for	syntax	highlighting,	code	completion,	and	more.	20/01/2021	·	In	addition	to	the	main	points	outlined	there's	a	lot	more	that	you	can	do	with	VSCode	to	help	make	coding	easier	and	more	productive.	One	of	these	features	is	Emmet.	This	is	a	built-in	extension	that	allows	you	to	skip	the	step	of	manually	typing	out	HTML
tags.	By	using	keyboard	shortcuts,	the	tags	are	automatically	created.	Download	Printable	VSCode	Keyboard	Shortcuts	PNG.	To	allow	even	more	keyboard	shortcuts	VSCode	allows	Second	key	of	chord.	This	means	you	have	to	press	the	secondary	key	after	original	shortcut	combination.	In	this	guide	when	you	see	Ctrl+K	Ctrl+S	it's	the	same	as
Ctrl+K,	then	S.	In	this	case	"S"	key	is	the	second	key	of	chord.	打开	Keyboard	Shortcuts	（快捷键是	CTRL+K	CTRL+S），在搜索框中搜索	ALT+-。	这个时候你会看到这个快捷键已经被绑定了（别慌），点开	keybindings.json	文件（点击下图右上角的花括号），我们去给这个快捷键设置不同情境下新的含义。	28/07/2020	·	I	don’t	like	moving	my	fingers	off	the	keyboard.	No
mouse,	no	arrow	keys,	no	track	pad.	Productive	use	of	time	dictates	finger	should	not	move	far	from	the	home-row	keys.	This	is	why	I	enabled	the	vim	extension.	To	run	a	Python	script	within	a	terminal	in	vsCode	you	have	to	click	the	play	button	in	the	upper	right	corner	of	the	screen:	Remember	rule	#1,	I	don’t	want	to	…	20/11/2019	·	Then	switched
back	to	VSCode	and	the	keyboard	shortcuts	were	working!!	Share.	Follow	answered	Sep	17,	2020	at	6:52.	retr0	retr0.	401	3	3	silver	badges	12	12	bronze	badges.	Add	a	comment	|	1	Resolved	:	Facing	similar	issue.	Several	keyboard	shortcuts	stop	working	when	code	starts	running.	In	my	case	it	was	happening	because	of	notepad++	extension.
15/07/2019	·	Acesse	seu	vscode:	file	>	preferences	>	Keyboard	Shortcuts.	Nessa	opção	irá	relacionar	todos	os	atalhos	do	seu	vscode,	se	quiser	filtrar,	basta	ir	digitando	os	atalhos	e	verá	algum	outro	comando	usando	mesmo	atalho,	basta	editar...inclusive,	ja	aproveita	para	fazer	otimizações	nos	seus	comandos.	The	original	keyboard	shortcut	for	split
editor	is	123.	I	switched	it	to	command	+	option	+	2.	To	switch	keyboard	shortcuts,	you	can	open	up	the	keyboard	shortcut	editor	by	opening	the	command	palette,	type	the	keyboard	shortcut,	then	click	the	pencil	icon	to	the	left	of	the	command	and	enter	your	new	command.	Toggle	editor	group	layout	This	keymap	has	covered	most	of	keyboard
shortcuts	of	VS	Code,	and	makes	VS	Code	more	'JetBrains	IDE	like'.	But	this	extension	hasn't	transfer	all	keybindings	of	JetBrains	yet.	If	you	want	more	feature,	go	to	GitHub	Issues	and	make	it	more	effective	for	your	developement.
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